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1 Introduction to RT-Eye InfiniBand Compliance Module 
This document provides the procedures for making InfiniBand SDR (Single Data Rate) compliance 
measurements with Tektronix TDS/CSA7000, DSA/DPO 70000 and TDS6000 series real time oscilloscopes 
(4 GHz models and above). The InfiniBand Compliance Module (Opt. IBA) is an optional software plug-in 
to the RT-Eye Serial Data Compliance and Analysis application (Opt. RTE). The InfiniBand Compliance 
module provides Amplitude, Timing, and Jitter measurements described in the electrical specification 
sections of the InfiniBand Architecture Specification.  

The IBTA-CIWG (InfiniBand Trade Association - Compliance and Interoperability Working Group) has 
defined a suite of electrical measurements that InfiniBand devices must pass to qualify for the InfiniBand 
Integrators List (IL). Manufacturers periodically perform these measurements on their InfiniBand devices at 
InfiniBand plugfests. The RT-Eye InfiniBand Compliance Module automates and provides Pass/Fail limit 
testing on many of these required IL measurements, as well as additional measurements that appear in the 
electrical specification.  

In the subsequent sections, step-by-step procedures are described to help you perform these measurements 
on your InfiniBand devices. Measurements that are required to qualify for the IL are noted as such and 
appear in the IBTA CIWG Subgroup Method of Implementation (MOI) document available for 
download to IBTA members at www.infinibandta.com.  

 

1.1 InfiniBand DDR and QDR Compliance Testing  
This document provides the procedures for making InfiniBand SDR (Single Data Rate – 2.5Gb/s) 
compliance measurements. While the InfiniBand Compliance Module does not support DDR and QDR 
rates, compliance testing for DDR and QDR rates can be performed by using the Serial Analysis Module 
of RT-Eye. Setup files for these compliance points can be found in the RT-Eye compliance library by 
selecting File > Recall > Setup > InfiniBand while in the Serial Analysis Module of RT-Eye. Available 
compliance test points are TP1 and TP6 as defined in the DDR and QDR sections of Chapter 6 of the 
InfiniBand specification.  

2 Background on InfiniBand Compliance Testing  
 

2.1 Compliance Statements and Test Definitions (TDs)  
Compliance statements appear in the InfiniBand architecture specification.  

Chapter 6 driver characteristics compliance statement are as follows:  

C6-7: All output ports SHALL comply with the parameters and notes of the Table 16 Driver 
Characteristics using appropriate parameters as noted. 

From compliance statements, the CIWG-PHY (Compliance and Interoperability Working Group – 
Physical Layer Subgroup) has developed Test Definitions (TDs) for measurements in Table 16. Test 
Definition assertions that have been given the following designations. 
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                            Table 1 – Chapter 6 Driver Test Definitions (TDs) from Table 16 of the specification  
 

CIWG-PHY 
TD 
Assertion 

Measurement Symbol in  
Chap. 6, Table 16 

 
Min 

 
Max 

V2c6-
007#01 

Common Mode Voltage VCM 0.5 V 1.0 V 

V2c6-
007#02 

Pk-Pk Differential Voltage Vdiff Table191 1.6 V 

V2c6-
007#03 

Disable Mode Output pk-pk Vdisable 0 85 mV 

V2c6-
007#03 

Disable Mode Output max Vdisable 0 1.6 V 

V2c6-
007#04 

Standby Mode Output pk-pk Vstandby 0 85 mV 

V2c6-
007#04 

Standby Mode Output max Vstandby 0 1.6 V 

V2c6-
007#05 

Driver Rise/Fall Time (20-80%) tDRF 100 ps  

 AC Common Mode Voltage VACCM  25 mV 

V2c6-
007#14 

Driver Total Jitter JT  Table19* 

V2c6-
007#14 

Driver Deterministic l Jitter JD  0.17UI 

 

                                                           
1 Minimum Differential Pk-Pk Voltage and Jitter @ 10-12 BER is dependent on Table 19 in Chapter 6 of the InfiniBand 
specification. Test Points (compliance points) are defined based on where in the system the measurement is being made. 
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   Figure 1 – Compliance Points from the InfiniBand Specification 

Chapter 7 Cable characteristics compliance statement is as follows: 

C7-16: Cable assemblies to be used for InfiniBand shall meet the electrical requirements listed in Table 30 
for all link widths for port type 1. 

   Table 2 – Chapter 7 Cable Test Definitions (TDs) from Table 30 of the Specification 
 

CIWG-PHY TD 
Assertion 

 
Measurement 

 
Symbol in  

 
Min 

 
Max 

V2c7-002#09 Cable Connector Near End Cross Talk       

V2c7-002#010 Cable Assembly Min Differential Voltage  VCout  316mV   

V2c07-016#01 

V2c07-016#02 

Cable Differential Impedance Zdca(nom) 

 

  

V2c07-016#05 Cable Connection Jitter Jca  .25UI 
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2.2 Integrator List Tests for InfiniBand 
Table 3 shows the measurements that are available in the RT-Eye InfiniBand Compliance Module and how 
they map to electrical measurements in Chapter 6 and Chapter 7 of the InfiniBand Architecture 
Specification. Also shown is whether or not the measurement is an Integrator List (IL) test. IL tests are 
required to have your device certified as InfiniBand compliant. Other measurements are useful, but not 
required. 

  Table 3 – RT-Eye Measurements Mapped to Chapter 6 and Chapter 7 Measurements 
 

 
Measurement 

 
Integrator List Tests 

Available in RT-Eye InfiniBand 
Compliance Module 

Electrical Driver Measurements (Chapter 6 of IBA Specification) 

Waveform Eye Height Yes Yes 

Waveform Eye Width No Yes 

Common Mode DC Voltage No Yes 

Common Mode AC Voltage No Yes 

Transmitter Peak-Peak Voltage Yes Yes 

Transmitter Transition Time  

(20-80 Rise/FallTime) 

Yes Yes 

Driver Total Jitter @ e-12 BER Yes Yes 

Electrical Cable Measurements (Chapter 7 of IBA Specification) 

Cable Connected Eye Height No Yes 

Cable Connected Eye Width  No Yes 

Cable Connection Jitter (TIE) Yes Yes 

Cable Connector Minimum Differential 
Voltage 

Yes Yes 

Cable Connector Near End CrossTalk Yes 

Cable Differential Impedance Yes 

No (Use TDS8000 series sampling 
oscilloscopes) 
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3 InfiniBand Driver Compliance Measurements (MOIs) 
This section applies Methods of Implementation (MOI) to the Test Definitions as they relate to Tektronix 
real-time oscilloscopes, probing solutions, and RT-Eye Serial Compliance and Analysis software. 

 

3.1 Required Equipment 
The following equipment is required to take the measurements in this document. 
• Tektronix TDS/CSA7000, DSA/DPO70000 and TDS6000 series real time oscilloscope (6 GHz BW or 

above) with RT-Eye software (Opt. RTE) and InfiniBand Compliance Module (IBA). 
• Probes – probing configuration is MOI specific. Refer to each MOI for proper probe configuration. 
• InfiniBand breakout cable (available from Fujikura Ltd.) 

 

  Figure 2 – Fujikura InfiniBand 4X Break-out harness 

 

3.2 Connecting to the driver under test 
The first step is to probe the link. Connect your probes based on one of the four methods described below.  

    Table 4 – Example probing configurations for an InfiniBand Link 
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3.2.1 SMA Connection 
 
1. Two TCA-SMA inputs using SMA 

cables (Ch1) and (Ch3)  
The differential signal is created by the 
RT-Eye software from the math 
waveform Ch1-Ch3. The Common 
mode AC measurement is also 
available in this configuration from the 
common mode waveform 
(Ch1+Ch3)/2. This probing technique 
requires breaking the link and 
terminating into the 50 Ω/side 
termination into the oscilloscope. While 
in this mode, the InfiniBand SerDes 
will transmit the 320 bit Jitter test 
pattern designed to maximize data 
dependent jitter. Ch-Ch deskew is 
required using this technique because 
two channels are used.  

 
Probe Configuration A 
SMA Psuedo-differential 

2. One P7300SMA Series differential 
active probe (Ch1) 
The differential signal is measured 
across the termination resistors inside 
the P7300SMA Series probe. This 
probing technique requires breaking the 
link. While in this mode, the InfiniBand 
SerDes will transmit the 320 bit Jitter 
test pattern designed to maximize data 
dependent jitter. Matched cables are 
provided with the P7300SMA probe to 
avoid introducing de-skew into the 
system. Only one channel of the 
oscilloscope is used.  

Probe Configuration B 
SMA Input Differential Probe 
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3.2.2 ECB pad connection 
 
3. Two single ended active probes (Ch1) 

and (Ch3) 
The differential signal is created by the 
RT-Eye software from the math 
waveform Ch1-Ch3. The Common mode 
AC measurement is also available in this 
configuration from the common mode 
waveform (Ch1+Ch3)/2. This probing 
technique can be used for either a live 
link that is transmitting data, or a link 
terminated into a “dummy load.” In both 
cases, the single ended signals should be 
probed as close as possible to the 
termination resistors on both sides with 
the shortest ground connection possible. 
Ch-Ch deskew is required using this 
technique because two channels are used. 

 
Probe Configuration C 

Two Single Ended Active Probes 

4. One Differential probe 
The differential signal is measured 
directly across the termination resistors. 
This probing technique can be used for 
either a live link that is transmitting data, 
or a link terminated into a “dummy load.” 
In both cases, the signals should be 
probed as close as possible to the 
termination resistors. A single channel of 
the oscilloscope is used, so de-skew is not 
necessary. Two differential probes can be 
used to create probing configuration 
shown in configuration “C” above. 

 
Probe Configuration D 

One Differential Active Probe 

 

4 Configuring a Device Under Test (DUT)  
To perform compliance measurements on an InfiniBand link, it is required that the link be configured to 
generate Back to Back TS1 (BTBTS1) test pattern. The following describes various methods of obtaining a 
TS1 signal out of ones HCA/TCA. 

Beacon Method. The InfiniBand beacon signal is the default signal which is broadcast on a repeating basis 
when there is no form of link established. The Beacon is comprised of 100 mSec of sleep state followed by 
1 mSec of TS1’s back to back. A simple edge trigger on an instrument is capable of triggering on the leading 
edge of this 1 mSec interval of the TS1’s. It is recommended, however that one use a delayed trigger of at 
least 50 μSec ensure that the RC ramping found on the leading edge of this TS1 beacon is excluded from 
any measurement. The trigger menu setup from TDS oscilloscopes to establish this delay is shown in Figure 
3. 
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          Figure 3 – Beacon method 

Loop-Back Method. This method loops back the transmit line from an unused lane into the receive lane 0 
(Figure 4). This results in a periodic (100 mSec) link state training machine stimulus into IbtxIn(0) which 
triggers a state change into the LTSM’s "configuration" state. The LTSM will broadcast 100 mSec of TS1’s 
in a back to back form. This is the simplest method for generating the BTBTS1 pattern. 

Note: The LTSM’s Config.RcvrCfg state generally cycles back around immediately into the 
Config.debounce state in this configuration with no non-deterministic intervals introduced. Some systems 
handle the transition through the LinkDown Default Idle state differently, and this transition can lead to a 
short non-deterministic delay of ~30 mSec before recycling into the Config.debounce state. In these systems, 
use the Instruments timeout trigger capability (dial in 10mSec timeout) combined with a trigger delay to 
ensure that this region of non-determinstic pre Donfig.debounce idle state does not appear in the region of 
data over which jitter computations would occur. Failure to do this can result in an “insufficient number of 
pattern repeats” warning.  

  

  Figure 4 – Loop back method 

 

5 Initial Oscilloscope Setup 
After hooking up to the DUT with the proper probing configuration for the test, press the DEFAULT front-
panel button and then the AUTOSET button to display the serial data bit stream. 
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6 Running the RT-Eye Software 
1. Go to File > Run Application > RT-Eye Serial Compliance and Analysis. 

 

                                 Figure 5 – Default menu of the RT-Eye software 

Figure 5 shows the oscilloscope display. The default mode of the software is the Serial Analysis module 
(Opt. RTE). This software is intended for generalized Serial Data analysis on 8B/10B encoded copper links. 

2. Select the InfiniBand Compliance Module from the Modules dropdown list.  

 

                  Figure 6 – Choosing the InfiniBand Compliance Module 

Note: If InfiniBand does not appear in the list, the InfiniBand Compliance Module (Opt. IBA) has not been 
installed.  

The rest of this document details use of the RT-Eye InfiniBand Compliance Module to perform electrical 
compliance measurements. 

Online Help is available under the Help Menu for the software when it is in the Serial Analysis Module. For 
information not contained in this document, refer to the RT-Eye online help or the printable format. 
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6.1 DC Common Mode Measurement MOI 
This test checks DC common mode voltage from the driver using Tektronix real-time oscilloscope, probes, 
and RT-Eye compliance software. This test checks the common mode voltage level of the transmitter 
output signal, is defined for a single physical bit lane, and must be repeated for each bit lane of each port 
on the DUT.  

• TD Assertion covered: V2c6-007.  

• VCM is defined in Vol. 2, Section 6.4, table Differential Output DC Characteristics,  
Maximum VCM=1.0 V and Minimum VCM=0.50 V.  

• Integrator List Test: No. 

• DUT Signaling: The test is performed on the TS1 ordered-sets captured by the oscilloscope while the 
DUT is in the Polling Active state described in section 3.3. 

• Probing Configuration: Probe Configuration C - Use two active probes. 

• Test Procedure is as follows: 

• Connect the probe for the positive leg of the differential to Ch1 and the negative leg to Ch3. 

• In the RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type.  

• Select CM Voltage as the measurement. 

• Select the Configure Button to access the Configuration menu. 

• Select the Source Tab and set up that menu as follows:  

o Live as the Source Type. 

o Select Ch1, Ch3 as the D+, D-. 

• Select the Start button. 

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement. 
See Figure 7.  

 
   Figure 7 – Result of the DC Common Mode Measurement 
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6.2 AC Common Mode Measurement MOI 
This test checks the AC common mode voltage from the driver using a Tektronix real-time oscilloscope 
and RT-Eye software. This test checks the common mode voltage level of the transmitter output signal, is 
defined for a single physical bit lane, and must be repeated for each bit lane of each port on the DUT.  

• TD Assertion covered: None. 

• VCM is defined in Vol. 2, Section 6.4, table Differential Output DC Characteristics,  
Maximum VACCM =25 mV RMS.  

• Integrator List Test: No. 

• DUT Signaling: The test is performed on the TS1 ordered-sets captured by the oscilloscope while the 
DUT is in the Polling Active state described in section 3.3. 

• Probing Configurations (from section 3.2):  

• Configuration A – Use TCA-SMA connectors with blocking capacitors. 

• Configuration C – Use two active probes. 

• Test Procedure as follows:  

• Connect the probe for the positive leg of the differential to Ch1 and the negative leg to Ch3. 

• In the RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type.  

• Select AC CM Voltage as the measurement.  

• Select the Configure button to access the Configuration menus. 

• Select the Source tab and set up that menu as follows:  

o Live as the Source Type. 

o Select Ch1, Ch3 as the D+, D-. 

• Select the Start button. 

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement. 
See Figure 8.  

 
   Figure 8 – Result of AC Common Mode Measurement 
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6.3 Transmitter Peak-Peak Measurement MOI 
This test checks the Pk-Pk voltage from the driver using a Tektronix real-time oscilloscope and RT-Eye 
software. This test checks the Pk-Pk differential voltage level of the transmitter output signal, is defined for 
a single physical bit lane, and must be repeated for each bit lane of each port on the DUT. An eye diagram 
is displayed to give additional information on the health of the transmitter. 

• TD Assertion covered: V2c6-007#02 

• Vdiff is defined in Vol. 2, Section 6.4, table Differential Output Differential Pk-Pk Voltage 
Characteristics. 
Maximum Vdiff = 1.6 V Pk-Pk, Minimum Vdiff is dependent on the test point. 

   Table 5 – Chapter 6 Test Point Descriptions, from Table 19 of the Specification* 
 

 
Test 
point 

 
Description 

Unsigned 
Waveform 
Amplitude  
(IEEE181) 

 
Eye Width 

TP1 Transmitted signal at the board side of the backplane connector .800 250 ps 

TP2 Transmitted signal at the backplane side of the backplane connector .750 240 ps 

TP3 Received signal at the board side of the connector .316 150 ps 

TP4 Received signal at the backplane side of the connector .335 160 ps 

TP5 Transmitted signal at the board side of the cable connector .890 250 ps 

TP6 Transmitted signal at the cable side of the cable connector .820 240 ps 

TP7 Received signal at the board side of the cable connector .282 150 ps 

TP8 Received signal at the cable side of the cable connector .300 160 ps 

TP9 Transmitted signal at the board side of the pluggable interface socket  .890 296 ps 

TP10 Received signal at the board side of the pluggable interface socket .282 126 ps 

* Measurements will require de-embedding or other compensation technique for properties of measurement 
fixtures and test equipment. 

 

• Integrator List Test: Yes 

• DUT Signaling: The test is performed on the TS1 ordered-sets captured by the oscilloscope while the 
DUT is in the Polling Active state described in section 3.3. 

• Probing Configurations (from section 3.2):  

• Configuration A – Use TCA-SMA connectors with blocking capacitors. 

• Configuration B – Use P7300SMA Series probe (recommended). 

• Connect via port breakout (Fujikura fixture in 4X case) to SMA inputs of probe configuration. 

• Test Procedure is as follows: 

• Connect the SMA connectors from the Break-out Harness to Ch1 and Ch3 of the oscilloscope, or 
to Ch1 depending on the probe configuration used. 

• In the RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type if using 
probe configuration (A), or Differential as the Probe Type if using probe configuration (B).  
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• Select Eye Height and Differential Voltage as the measurements. 

• Select the Configure button to access the Configuration menus. 

• Select the Source tab and set up that menu as follows:  

o Live as the Source Type. 

o Select Ch1, Ch3 as the D+, D- if using probe configuration (A) or select Ch1 if using probe 
configuration (B).  

• Select the Meas Params tab and set up that menu as follows: 

o TP6 (Transmitted signal at the cable side of the cable connector) as the Test Point. 

o Stand By or Disable as the Differential Voltage Mode.  

• Select the Start button. 
 

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement. 
See Figure 9.  

 
                            Figure 9 - Result of the Differential Amplitude Measurement  

The last two lines report Pass/Fail on Min and Max of Diff Voltage. The waveform is also compared to a 
waveform mask where the vertical and horizontal dimensions are defined by amplitude and jitter eye 
width.  

 

6.4 Rise/Fall Time Measurements 
This test checks the Transition Times from the driver using Tektronix real-time oscilloscope and RT-Eye 
software. This test checks the 20-80% Rise/Fall times of the transmitter output signal and compares them 
against the specified limits. This test is defined for a single physical bit lane and must be repeated for each 
bit lane of each port on the DUT.  

• TD Assertion covered: V2c6-007#05 

• tDRF is defined in Vol. 2, Section 6.4, Table 16 of the specification, Characteristics  
Minimum tDRF = 100 ps. 
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• Integrator List Test: Yes 

• DUT Signaling: The test is performed on the TS1 ordered-sets captured by the oscilloscope while the 
DUT is in the Polling Active state described in section 3.3. 

• Probing Configurations (from section 3.2):  

• Configuration A – Use TCA-SMA connectors with blocking capacitors. 

• Configuration B – Use P7300SMA Series probe (recommended). 

• Connect via port breakout (Fujikura fixture in 4X case) to SMA inputs of probe configuration. 

• Test Procedure is as follows:  

• Connect the SMA connectors from the Break-out Harness to Ch1 and Ch3 of the oscilloscope, or 
to Ch1 depending on the probe configuration used. 

• In the RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type if using 
probe configuration (A) or Differential as the Probe Type if using probe configuration (B).  

• Select Eye Height and Differential Voltage as the measurements. 

• Select the Configure button to access the Configuration menus. 

• Select the Source tab and set up that menu as follows:  

o Live as the Source Type. 

o Select Ch1, Ch3 as the D+, D- option if using probe configuration (A), or select Ch1 if using 
probe configuration (B). 

• Select the Meas Params tab and set up that menu as follows: 

o TP6 (Transmitted signal at the cable side of the cable connector) as the Test Point. 

o Stand By or Disable as the Differential Voltage Mode.  

• Select the Start button. 
 

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement. 
See Figure 10.  

 

 
Figure 10 - Results of Transition Time Test 
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6.5 Driver Jitter Measurements 
This test checks the Total Jitter from the driver using Tektronix real-time oscilloscope and RT-Eye 
software. This test checks the values of Total Jitter @ 10-12 BER and Deterministic Jitter and compares 
them against the specified limits. This test is defined for a single physical bit lane and must be repeated for 
each bit lane of each port on the DUT.  

• TD Assertion covered: V2c6-007#14 

• Total Jitter (JT) and Deterministic Jitter (JD) for the driver are defined in Vol. 2, Section 6.4, Table 
16 Driver Characteristics. Jitter Eye Opening at different compliance points are defined in Table 5.  

• Integrator List Test: Yes 

• DUT Signaling: The test is performed on the TS1 ordered-sets captured by the oscilloscope while the 
DUT is in the Polling Active state described in section 3.3. 

• Probing Configurations (from section 3.2):  

• Configuration A – Use TCA-SMA connectors with blocking capacitors. 

• Configuration B – Use P7300SMA Series probe (recommended). 

• Connect via port breakout (Fujikura fixture in 4X case) to SMA inputs of probe configuration. 

• Test Procedure is as follows:  

• Connect the SMA connectors from the Break-out Harness to Ch1 and Ch3 of the oscilloscope, or 
to Ch1 depending on the probe configuration used. 

• In the RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type if using 
probe configuration (A) or Differential as the Probe Type if using probe configuration (B).  

• Select Jitter @ BER as the measurement. 

• Select the Configure button to access the Configuration menus. 

• Select the Source tab and set up that menu as follows:  

o Live as the Source Type. 

o Select Ch1, Ch3 as the D+, D- option if using probe configuration (A), or select Ch1 if using 
probe configuration (B). 

• Select the Meas Params tab and set up that menu as follows: 

o TP6 (Transmitted signal at the cable side of the cable connector) as the Test Point. 

o Stand By or Disable as the Differential Voltage Mode.  

• Select the Start button. 

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement. 
See Figure 11.  
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  Figure 11 - Results of the Jitter Eye Opening @ 10-12 BER Measurement  

The results of the Total Jitter can be directly compared to Table 5, where: 

 Total Jitter + Jitter Eye Opening = 400ps (1UI) 

Deterministic Jitter can be viewed by selecting it in the Measurement Details menu as shown in Figure 12. 
 

 
Figure 12 – Deterministic jitter results 
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6.6 Combining Driver Measurements 
Using the RT-Eye InfiniBand Compliance Module (Opt. IBA), all measurements can be made in a single 
acquisition. Measurements that can be combined into a single acquisition are as follows: 

• Eye Height/Eye Width 

• Rise Time/Fall Time 

• Unit Interval 

• Jitter @ BER (RJ, DJ, TJ, and Jitter Eye Opening) 

• Differential Voltage 
 

 

Figure 13 – Combining all measurements into a single test 
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7 InfiniBand Cable Measurements 
 

7.1 Required Equipment 
The following equipment is required to make the measurements in this document. 

• TDS/CSA7404 or TDS6000 OR DPO/DSA70000 series oscilloscope equipped with TDS RT-Eye 
software (Opt. RTE) and InfiniBand Compliance Module (IBA). 

• DTG5000, AWG710 or AWG7102 signal generator. 

• Probes – Probing configuration is MOI specific. Refer to each MOI for proper probe configuration. 

• InfiniBand cable test fixture (available from Gore; see Figure 14) 

 
           Figure 14 – Gore cable test fixture  

 

7.2 Connecting to the Driver Under Test 
The connection method to the Device Under Test is shown in Figure 15. 

IB Connector

2.5Gb/Sec Aggressor Signal

Low Jitter
(<30pSec Pk)
Signal Source

 
    Figure 15 – Test Setup for IB cable testing 

 

This test setup shows the use of a P7300SMA Series Differential Active probe with SMA inputs. 
Alternatively, each leg of the differential signal being tested can be connected to Ch1 and Ch3 of the 
oscilloscope and the measurement can be made in a pseudo-differential manner. 
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7.3 Configuring the Device Under Test (DUT)  
The signal generator is set up to transmit a repeating CJTPAT (Compliance Jitter Test Pattern).  

 

7.4 Initial Oscilloscope Setup 
After connecting to the DUT with the proper probing configuration for the test, press the DEFAULT front-
panel button and then the AUTOSET button to display the serial data bit stream. 

 

7.5 Running the RT-Eye Software 
Go to File > Run Application > RT-Eye Serial Compliance and Analysis. The result should be similar to 
Figure 3. 

 

7.6 Cable Connected Minimum Differential Voltage 
This test checks cable assembly minimum differential voltage using Tektronix real-time oscilloscope and 
signal source. This test checks the minimum differential output voltage peak to peak of the Cable 
connector output signal. This test is defined for a single physical bit lane and must be repeated for each bit 
lane on the DUT (differential pair of cable). 

• TD Assertion covered: V2c7-002#010 

• Total Jitter (JT) and Deterministic Jitter (JD) for the driver are defined in Vol. 2, Section 6.4, Table 
16 Driver Characteristics. Jitter Eye Opening at different compliance points are defined in Table 19 
of the specification.  

Notes: 

• The test applies to the cable connector and to the cable assembly (ambiguously defined in the 
InfiniBand Architecture Specification 1.1) 

• Differential Amplitude = 1 Vpp  

•  VCout (peak-peak), minimum differential output Voltage (peak-peak) limits defined in Vol.2, 
Section 7.9.2, table Cable assembly electrical performance requirements.  

• Vmeas is the minimum differential voltage measured at the center of the eye Diagram (Eye 
Height).  

• Test must be performed on each lane on the DUT.  

• Integrator List Test: Yes 

• DUT Signaling: The test is performed on the CJTPAT Ordered Sets captured by the oscilloscope. 
The voltage measurement is taken for 1 Vpp Fibre Channel CJTPAT stimulus for 1000 waveforms or 
equivalent. 

• Probing Configurations (from section 3.2):  

• Configuration A – Use TCA-SMA connectors with blocking capacitors. 

• Configuration B – Use P7300SMA Series probe (recommended). 

• Connect via port breakout (Fujikura fixture in 4X case) to SMA inputs of probe configuration. 
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• Test Procedure: 

• Connect SMA connectors from Break-out Harness to Ch1 and Ch3 of the oscilloscope, or to Ch1 
depending on the probe configuration used. 

• In the RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type if using 
probe configuration (A) or Differential as the Probe Type if using probe configuration (B).  

• Select Cable Assembly from the Test dropdown. 

• Select Eye Width/Eye Height and TIE Jitter as the measurement. 

• Select the Configure button to access the Configuration menus.  

• Select the Source tab and set up that menu as follows: 

o Live as the Source Type. 

o Select Ch1, Ch3 as the D+, D- if using probe configuration (A) or select Ch1 if using probe 
configuration (B). 

• Select the Start button.  

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement. 
See Figure 16.   

 
             Figure 16 - Results of the Cable Connected Minimum Differential test 
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8 Giving a Device an ID 
The InfiniBand Compliance Module provides a graphical user interface for entering a Device ID and 
Description. Data entered here will appear on the compliance report and is recommended for device 
tracking.  

9 Creating a Compliance Report 
To create a compliance report, select Utilities > Reports. The Report Generator utility can create a complete 
report of the compliance test. 

10 Appendix A – Measurement Algorithms 
Refer to the RT-Eye software’s online help (OLH) for measurement Algorithm information.  
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